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Supported Papers
A large amount of information is stored in your printer as printable pages. The following pages show 
the Paper Tips printable page, which provides information on the supported papers.

All the printable pages have this format, with color bars at the top and at the bottom of the page. Print 
these pages at the printer’s front panel. 

Accessing printable pages

Access these pages from the Printable Pages Menu:

1. At the front panel, scroll to the Printable Pages Menu using the Down Arrow or 
Up Arrow key and press the OK key.

2. Scroll to the desired printable page (such as Print Paper Tips Page) using the Down 
Arrow or Up Arrow key and press the OK key.

Menu Map

For a complete list of printable pages, print the Menu Map:

1. Select Menus on the front panel and press the OK key.

2. Select Print Menu Map and press the OK key.

6200-51



Heavy Plain Paper
85 - 105 g/m2 (22 - 28 lb Bond) Trays 1 - 3

MPT
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Paper Type
Plain Paper

Transparency

Thin Card Stock

Thick Card Stock

Envelope
You can also use custom envelope sizes.

Labels

Glossy Coated Paper

Business Cards

Greeting Cards

CD/DVD Labels and CD/DVD Inserts

100 - 163 g/m2 (26 - 60 lb Cover)

160 - 216 g/m2 (59 - 80 lb Cover)

120 - 163 g/m2 (81 - 110 lb Book)

64 - 90 g/m2 (17 - 24 lb Bond)
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#10 Commercial Envelope (4.12 x 9.5 in.)
Monarch Envelope (3.87 x 7.5 in.)
A7 Envelope (5.25 x 7.25 in.)
Custom

DL Envelope (110 x 220 mm)
C5 Envelope (162 x 229 mm)
C6 Envelope (114 x 162 mm)
B5 Envelope (176 x 250 mm)

Tray

Trays 1 - 3

MPT

MPT

MPT

MPT

MPT

Tray 1

MPT

MPT

MPT

MPT

MPT

MPT

The Multi-Purpose Tray (MPT) and other trays use only certain sizes and types of paper or transparencies. Follow these tables to ensure the best print 
quality and to avoid paper jams. For best results, use only Xerox Phaser® branded media as it is guaranteed to produce excellent results on your �
Phaser® 6200 Printer - the Phaser® 6200 and Phaser® media are Made for Each Other.®  

Caution: Use only paper envelopes. Do not use envelopes �
with windows or metal clasps.

Caution: Do not print on label stock once labels have been removed.

Caution: Do not use glossy ink-jet paper or non-laser glossy paper as they 
may cause damage to the printer's fuser.

Caution: Do not print business card media once cards have been removed.

Caution: Do not print label or insert media once labels or inserts have    
been removed.

Caution: Use only Phaser®  6200 Premium Transparency Film. �
Other transparencies may damage the printer's fuser.

Caution: Damage caused by using unsupported �
media is not covered by your printer's warranty.
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Letterhead
85 - 105 g/m2 (22 - 28 lb Bond) 

Note:  Auto duplexing is only supported from Trays 1 - 3, on 75 - 105 g/m2 (20 - 28 lb Bond) media.
          This option is not available on the Phaser 6200B and Phaser 6200N.

Photo Paper
120 - 163 g/m2 (81 - 110 lb)

MPT

Trays 1 - 3

PHASER® 6200 COLOR PRINTER
Paper Tips



Part Number

016-1368-00
016-1369-00

016-1823-00
016-1824-00

016-1812-00
016-1814-00
016-1813-00
016-1815-00

016-1704-00

016-1705-00

016-1898-00
016-1899-00

016-1987-00

016-1988-00

016-2011-00

016-2026-00

Size

Letter
A4

Letter

A4

Letter
A4

Letter
A4
Letter
A4

Letter

A4

Letter
A4

Letter

A4

Letter

A4

Premium Color Printing Paper, 500 Sheets

6200 Premium Transparency, 50 Sheets

Premium Cover Paper, 100 Sheets

Color Printing Labels, 30/Sheet, 100 Sheets
Color Printing Labels, 14/Sheet, 100 Sheets
Color Printing Labels, 6/Sheet, 100 Sheets
Color Printing Labels, 8/Sheet, 100 Sheets

Glossy Coated Paper, 100 Sheets

Premium Business Cards,10/Sheet, 25Sheets

Premium Greeting Cards with Envelopes, 25 Sheets/Envelopes

CD/DVD Labels and Inserts  

Paper Type Phaser® Branded Media

Plain Paper
Heavy Plain Paper

Transparency

Thin Card Stock

Label

Glossy Coated Paper

Business Card

Greeting Card

CD/DVD Label

Paper tips
   •  If excessive jams occur, flip and fan the paper in the tray or install fresh paper �
      from an unopened ream.

   •  Transparencies should be fanned prior to loading.

   •  Using non-Phaser® 6200 PremiumTransparencies may cause print quality problems �
      or damage to the fuser.

   •  Other size envelopes may be printed in custom mode. 

   •  Use only paper envelopes. Do not use envelopes with windows or metal clasps.

   •  Label media should be fanned prior to loading.

   •  Do not print on label, business card or CD/DVD insert sheets once a they have been removed �
      from the printer.

20 Labels and Inserts

Page 2 of 2

See www.xerox.com/officeprinting/6200supplies for information on ordering supplies.

Note: Damage caused by using non-supported media will not be covered under the warranty, 
service agreement or Total Satisfaction Guarantee.

016-2009-00

016-2010-00

Letter

A4
Photo Paper Digital Photo Paper 50 Sheets

016-1948-00

016-1949-00
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Trays 
This section covers:

� Loading paper in Trays 1-3 — see page 2.

� Loading paper in the Multi-Purpose Tray — see page 6.

� Using custom size paper — see page 8.

For a list of the acceptable papers, transparencies, envelopes, and labels that can be used in each tray, 
refer to the Supported Papers section of the Trays and Paper Guide on the Interactive Documentation 
CD-ROM.

Note

Do not load a tray that is currently being used for printing.

You MUST set the paper type in the printer’s front panel any time you add paper to the printer. If you 
change paper types, take a moment to ensure that the front panel values agree with the paper you have 
loaded. If you fail to do this, you can damage the printer’s fuser.

Loading paper in Trays 1-3  

Caution

Phaser® 6200 Transparency film is designed specifically to work with this printer's oil-less 
fuser. Using non-Phaser 6200 Transparencies might result in poor image quality and might 
damage the fuser. Damage caused by using non-Phaser 6200 Transparencies is not covered 
under the warranty, service agreement, or Total Satisfaction Guarantee. To order 
Phaser® 6200 Transparencies, visit the Phaser® 6200 Supplies and Accessories web site. 
DO NOT load Phaser® 6200 Transparency Film in Trays 2 or 3; use Tray 1 or the 
Multi-Purpose Tray instead.

Caution

DO NOT load card stock, glossy coated paper, photo paper, envelopes, labels, business 
cards, greeting cards, CD/DVD labels, and CD/DVD inserts in Trays 1-3; use the 
Multi-Purpose Tray instead.

To load paper in Trays 1-3:

Instructional videos for loading trays are available on the Interactive Documentation 
CD-ROM or the Xerox web site at: www.xerox.com/officeprinting/6200support/

You can also refer to the labels inside the printer for paper loading instructions.

Note

If you change the type of paper, you MUST 
specify the type on the front panel of the printer.

OK

6200-46

www.xerox.com/officeprinting/6200support
www.xerox.com/officeprinting/6200supplies
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1. Pull out the tray. 

2. If loading paper having a different width, push the width guides outward. If loading paper having a 
different length, tilt the back guide forward, slide the guide, and insert the pins on the bottom of 
the guide into the holes in the tray corresponding to the paper size you are loading. 

3.  Fan the paper to release sheets that are stuck together. 

6200-35

6200-01
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4. Insert a stack of paper into the tray. Place the paper under the front corner tabs and under the tabs 
on the back guide. For one-sided prints, place the side to be printed faceup with the top of the page 
at the front of the tray. For two-sided prints, place the side to be printed with the odd-numbered 
pages facedown with the top of the page at the back of the tray. If using paper with pre-punched 
holes, place the holes toward the right side of the tray.

Note

Observe the fill lines on the side of the tray. Do not load paper above the paper fill line (1), 
because it may cause a jam. Do not load transparencies above the transparency fill line (2).

5. If necessary, push the width guides inward to match the size of the paper.  

MAX

6200-03

1

2MAX

6200-04
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6. Insert the tray and push it completely into the printer. 

7. When the front panel prompts you:

� If you haven’t changed the type of paper, press the OK key to accept the current setting for 
paper type.

� If you have changed the type of paper, scroll to the correct paper type and press the OK key 
to save your selection. 

Note

To avoid possible print-quality and paper-feed problems, make sure that the tray’s paper type 
setting matches the loaded paper type.

6200-36

OK

6200-45
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Loading paper in the Multi-Purpose Tray
Use the Multi-Purpose Tray for envelopes, transparencies, custom size paper, and specialty papers, such 
as labels, business cards, greeting cards, CD/DVD labels, and CD/DVD inserts as well as paper.  

Caution

Phaser® 6200 Transparency film is designed specifically to work with this printer's oil-less 
fuser. Using non-Phaser 6200 Transparencies might result in poor image quality and might 
damage the fuser. Damage caused by using non-Phaser 6200 Transparencies is not covered 
under the warranty, service agreement, or Total Satisfaction Guarantee. To order 
Phaser® 6200 Transparencies, visit the Phaser® 6200 Supplies and Accessories web site.
DO NOT load Phaser® 6200 Transparency Film in Trays 2 or 3; use Tray 1 or the Multi-
Purpose Tray instead.

Note

Automatic 2-sided printing is not available from the Multi-Purpose Tray.

To load paper in the Multi-Purpose Tray:

1. Open the Multi-Purpose Tray (labeled MPT) by pushing the handle down and out.   

Note

If you change the type or size of paper, you 
MUST specify the type and size on the front 
panel of the printer.

OK

6200-46

6200-06
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2. Adjust the width guides to match the size of the paper. 

3. Insert the paper, transparencies, or envelopes in the Multi-Purpose Tray. Load the side to be 
printed facedown with the top of the page entering the printer first. Do not load paper above the 
fill line. Place envelopes with the flap side up and top of the envelope towards the right of the 
printer. (For A7 envelopes, place the flap side up but have the top of the envelope enter the printer 
first.) 

4. When the front panel prompts you and you haven’t changed the type or size of paper, press the 
OK key to accept the current settings for type and size.

6200-07

6200-08 6200-10
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5. If you have changed the type or size of paper:

a. On the printer’s front panel, scroll to Change by pressing the Down Arrow key, then press 
the OK key.

b. Scroll to the correct paper type and press the OK key to save your selection.

c. Scroll to the correct paper size and press the OK key to save your selection. 

Note

To avoid possible print-quality and paper-feed problems, make sure that the tray’s paper type 
and size settings match the loaded paper type.

Using custom size paper
In addition to the wide variety of standard paper sizes available for this printer, you can use custom size 
paper in the Multi-Purpose Tray. 

Loading custom size paper in the Multi-Purpose Tray
1. Open the Multi-Purpose Tray, as described on page 6.

2. Insert the custom size paper and adjust the guides to match the size of the paper. Place the side to 
be printed facedown with the top of the page entering the printer first.  

Size Range

X dimension 89 mm - 216 mm

3.5 in. - 8.5 in.

Y dimension 140 mm - 356 mm

5.5 in. - 14 in.

OK

6200-45

6200-57

1

2
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3. When the front panel prompts you to confirm the type and size of paper:

a. Scroll to Change (by pressing the Down Arrow key) and press the OK key.

b. Scroll to the correct paper type and press the OK key to save your selection.

c. For the paper size, scroll to Custom and press the OK key.

d. Select Set Custom X by pressing the OK key.

e. Press the Down Arrow or Up Arrow key to scroll to the desired value for X (labeled 2 in the 
illustration in Step 2) and then press the OK key.

f. Scroll to Set Custom Y and press the OK key.

g. Press the Down Arrow or Up Arrow key to scroll to the desired value for Y (labeled 1 in the 
illustration in Step 2) and then press the OK key.
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Specialty Printing
This section covers:

� Automatic 2-sided printing — see page 10.

� Manual 2-sided printing — see page 12.

� Transparencies — see page 15.

� Envelopes — see page 18.

� Labels, Business Cards, Greeting Cards, CD/DVD Inserts, and CD/DVD Labels — 
see page 19.

For a list of the acceptable papers, transparencies, envelopes, and labels that can be used in each tray, 
refer to the Supported Papers section of the Trays and Paper Guide on the Interactive Documentation 
CD-ROM or print the Paper Tips page from the printer’s front panel.

Automatic 2-sided printing
To have the printer do automatic 2-sided printing (duplexing):

� The printer must be either a Phaser 6200 DP or Phaser 6200 DX model.

� The paper must be loaded in a tray. The printer will NOT do automatic 2-sided printing on paper 
loaded in the Multi-Purpose Tray.

� Any supported paper size that is supported in the tray can be duplexed. Any supported paper type 
(Plain Paper, Heavy Plain Paper, Letterhead, or Special) that can be loaded in the tray can be 
duplexed.

� The paper must have a weight of 75-105 g/m2 (20 - 28 lb. bond).

Caution

DO NOT use any specialty media (such as glossy coated paper), envelopes, or labels for 
2-sided printing. Any damage caused by duplexing specialty media may not be covered 
under your printer warranty.

For best results with automatic 2-sided printing, do not use heavy toner coverage on the even-numbered 
pages of your print job.

When you print any job, you can use the printer driver to select the orientation of the images on the 
page: Portrait or Landscape. When you print 2-sided jobs, you also select the binding preference, 
which determines how the pages turn; refer to the table on page 12 for the wording used in the printer 
drivers for binding preference.
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To do automatic 2-sided printing:

1. Insert a stack of paper into the tray. For more information, refer to the Trays section of the 
Trays and Paper Guide on the Interactive Documentation CD-ROM. Place the side to be 
printed with the odd-numbered pages facedown with the top of the page at the back of the tray. If 
using paper with pre-punched holes, place the holes toward the right side of the tray.

2. In the printer driver: 

� Select the tray containing the paper.

� Select the orientation.

� Select 2-sided printing, as described in the following table.

3. Send the job to the printer.

Portrait
Bind on Side Edge
Flip on Long Edge

Portrait
Bind on Top Edge
Flip on Short Edge

Landscape
Bind on Side Edge
Flip on Short Edge

Landscape
Bind on Top Edge
Flip on Long Edge

6200-58

PH
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Manual 2-sided printing
If the printer doesn’t have a duplex unit, you can still have the printer print on both sides of the paper. 
However, you must have the printer print all of the odd-numbered pages first, reinsert the printed pages 
in the tray, then have the printer print the even-numbered pages.

You can use Trays 1-3 or the Multi-Purpose Tray for manual 2-sided printing.

Paper specifics

� When using the Multi-Purpose Tray, the paper must have a weight of 75 - 216 g/m2 (20 - 58 lb. 
bond).

� When using the trays, the paper must have a weight of 75 - 105 g/m2 (20 - 28 lb. bond).

� For the best opacity and feed reliability, use Plain Paper that is 90 g/m2 (24 lb. bond) paper.

� 2-sided printing on specialty paper can shorten the life of printer components.

� For best results, do not use heavy toner coverage on side 1 of a manual 2-sided print. Increase the 
top margin on side 1 to at least 12 mm (0.48 in.).

� Print quality may be degraded on the second side of manual 2-sided prints.

Setting the printer driver for two-sided printing

Macintosh
LaserWriter 8.6
or 
LaserWriter 8.7

1. From the File menu, select Print.

2. In the Print dialog box, click after General and select Layout from the 
pull-down menu.

3. Select Print on Both Sides.

4. Select a binding preference.

Windows 95,

Windows 98, or

Windows Me

1. From the File menu, select Print.

2. Click the Properties button.

3. On the Setup tab, select Print on 2 Sides.

4. Check or uncheck Bind on Top Edge.

Windows 2000

or

Windows XP

1. From the File menu, select Print.

2. Click the Properties button.

3. On the Layout tab for Print on Both Sides (Duplex), select either 
Flip on Long Edge or Flip on Short Edge.

Windows NT 1. From the File menu, select Print.

2. Click the Properties button.

3. On the Page Setup tab for Print on Both Sides (Duplex Printing), 
select either Long Edge or Short Edge.
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Manual 2-sided printing using Trays 1-3

Printing side 1

1. Insert a stack of paper into the tray. For more information, refer to the Trays section of the 
Trays and Paper Guide on the Interactive Documentation CD-ROM. Place the side to be 
printed faceup with the top of the page at the front of the tray. 

2. In the printer driver, select the tray containing the paper.

3. Send the job to the printer so that the odd-numbered pages (side 1) are printed.

Printing side 2

1. Insert the paper printed with side 1 into the tray. Place the printed side 1 facedown with the top of 
the page at the front of the tray; (the side to be printed is faceup).

2. In the printer driver, select the tray containing the paper.

3. Send the job to the printer so that the even-numbered pages (side 2) are printed.

6200-77

6200-78
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Manual 2-sided printing using the Multi-Purpose Tray

Printing side 1

1. Insert a stack of paper into the Multi-Purpose Tray. For more information, refer to the Trays 
section of the Trays and Paper Guide on the Interactive Documentation CD-ROM. Load the 
side to be printed facedown with the top of the page entering the printer first. 

2. In the printer driver, select the Multi-Purpose Tray as the paper source.

3. Send the job to the printer so that the odd-numbered pages (side 1) are printed.

Printing side 2

1. Insert the paper printed with side 1 into the Multi-Purpose Tray. Place the printed side 1 faceup 
with the top of the page entering the printer first.

2. In the printer driver, select the Multi-Purpose Tray as the paper source.

3. Send the job to the printer so that the even-numbered pages (side 2) are printed.

PHASER 6200

6200-56
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Transparencies
Transparencies can be printed from Tray 1 or the Multi-Purpose Tray. Handle transparencies by the 
edges and with both hands to avoid fingerprints and creases, which can cause poor print quality. 

Xerox Phaser® 6200 Transparencies

Xerox recommends that you use Phaser® 6200 Transparencies, which have been specifically developed 
for use with this type of printer fuser.

To order supplies and accessories, contact your local reseller or visit the Xerox web site at:
www.xerox.com/officeprinting/6200supplies

Using non-Phaser 6200 transparency film 

The printer features a unique oil-less fuser. Phaser 6200 Transparency film is designed specifically to 
work with the printer's fuser. If you want to use non-Phaser 6200 transparency film, you must use a film 
that meets the following specifications:

� Compatible with oil-less fuser systems

� Fusing temperature: 178 degrees C

� Electrical surface resistivity: greater than 7 x 10exp11 ohm/square

Any overhead transparency materials used with this printer must be compatible with the heat and 
pressure of the oil-less fusing process. The materials must not discolor, melt, offset, or release 
hazardous emissions when heated to 178 degress C for 0.2 seconds.

Overhead transparency materials that do not meet these specifications can produce poor image quality, 
produce a jam in the printer, wrap around the fuser rollers and even melt on the fuser rollers. Some 
non-Phaser 6200 transparencies have paper tape on the edge that can separate in the heat of the fuser, 
leading to damage. Using non-Phaser 6200 transparencies may damage the fuser. Damage caused by 
using non-Phaser 6200 transparencies is not covered under the warranty, service agreement, or Total 
Satisfaction Guarantee.

Videos are available with instructions for loading transparencies. Videos are located on the 
Interactive Documentation CD-ROM and on the Xerox web site at: 
www.xerox.com/officeprinting/6200support/ 

Xerox Phaser® 6200 Premium Transparency Film

Size Description Part Number

A/Letter (U. S.)
8.5 x 11 in.

50 sheets 016-1948-00

A4 (Metric Letter)
210 x 297 mm

50 sheets 016-1949-00

http://www.tek.com/Color_Printers/supplies" target="_blank
www.xerox.com/officeprinting/6200support
www.xerox.com/officeprinting/6200supplies
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Note

Xerox and Xerox Phaser transparency films developed for other Xerox printers and copiers 
are not meant to be used with this printer. Using non-Phaser 6200 transparencies may 
damage the fuser and might not be covered under the warranty.

Printing transparencies from Tray 1
1. Fan the transparencies to release sheets that are stuck together.  

2. Insert the transparencies into the tray. For more information, refer to the Trays section of the 
Trays and Paper Guide on the Interactive Documentation CD-ROM.

3. Do not load transparencies above the transparency fill line, because it may cause a jam.

4. When the front panel prompts you to confirm or change the selected paper type:

a. Press the Down Arrow key to scroll to Change, then press the OK key.

b. Scroll to Transparency and press the OK key to save your selection.

5. In the printer driver, select either Tray 1 as the paper source or Transparencies as the paper type.

 

MAX

6200-59
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Printing transparencies from the Multi-Purpose Tray
1. Fan the transparencies to release sheets that are stuck together.  

2. Insert the transparencies into the Multi-Purpose Tray; (maximum capacity is 50 sheets). For more 
information, refer to the Trays section of the Trays and Paper Guide on the Interactive 
Documentation CD-ROM.

3. When the front panel prompts you to confirm or change the selected paper type and size:

a. Press the Down Arrow key to scroll to Change, then press the OK key.

b. Scroll to Transparency and press the OK key to save your selection.

c. Scroll to the correct paper size and press the OK key to save your selection.

4. In the printer driver, select either Multi-Purpose Tray as the paper source or Transparencies as 
the paper type.

6200-54
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Envelopes

Guidelines for envelope printing

� Envelopes can only be printed from the Multi-Purpose Tray.

� Use only paper envelopes.

� Do not print on the back of the envelope.

� Keep unused envelopes in their packaging to avoid the effects of moisture and dryness, 
which can affect print quality and cause wrinkling. Excessive moisture causes the envelopes 
to seal before or during printing.

� Many applications include a tool for creating an envelope document. For example, Microsoft 
Word includes an Envelopes and Labels feature in the Tools menu. Be sure to:

� Select facedown.

� Select the feed method with the image centered.

� Clear Clockwise Rotation.

� Load a maximum of 10 envelopes at a time. This printer is not designed to handle 
high-capacity production envelope printing.

� Envelopes may wrinkle depending on the weight and stiffness of the envelope. Envelopes 
with short flaps work best; longer flaps are more likely to wrinkle.

Caution

Never use envelopes with windows or metal clasps; they can damage the printer. Damage 
caused by using unsupported envelopes is not covered by your printer’s warranty.

Printing envelopes
1. Insert the envelopes short-edge feed into the Multi-Purpose Tray. For more information, refer to 

the Trays section of the Trays and Paper Guide on the Interactive Documentation CD-ROM.

� Place envelopes with the flap side up and top of the envelope towards the right of the printer. 
(For A7 envelopes, place the flap side up but have the top of the envelope enter the printer 
first.)

� Maximum capacity is 10 envelopes.

6200-10
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2. When the front panel prompts you to confirm or change the selected paper type and size:

a. Press the Down Arrow key to scroll to Change, then press the OK key.

b. Scroll to Envelopes and press the OK key to save your selection.

c. Scroll to the correct envelope size and press the OK key to save your selection.

3. In the printer driver, select either Multi-Purpose Tray as the paper source or Envelopes as the 
paper type.

4. Make a test print from your application to confirm that the orientation of your envelope is correct.

Note

The heat from the printing process can melt certain types of envelope glue. If the envelope 
flap sticks shut after printing the test print, tuck the flaps inside the envelopes when printing 
the remaining envelopes.

Labels, Business Cards, Greeting Cards, 
CD/DVD Inserts, and CD/DVD Labels
Labels, business cards, greeting cards, CD/DVD inserts, and CD/DVD labels can only be printed from 
the Multi-Purpose Tray. The number of sheets that can be loaded depends on the item. 

Refer to the Supplies section of the Support Guide on the Interactive Documentation CD-ROM for 
information on part numbers for ordering these items. To order supplies and accessories, contact your 
local reseller or visit the Xerox web site at: www.xerox.com/officeprinting/6200supplies

Guidelines

� Do not use vinyl labels.

� If any of the labels, cards, or inserts on a sheet are missing, do not use that sheet; it may 
damage printer components.

� Store unused labels, cards, and inserts flat in their original packages.

� Do not store labels, cards, or inserts in extremely dry or humid conditions or extremely hot or 
cold conditions. Storing them in extreme conditions may cause them to jam in the printer or 
cause print quality problems.

� Rotate stock frequently. Long periods of storage in extreme conditions can cause the labels, 
cards, and inserts to curl and jam the printer.

� Print only on one side of the sheet of labels and inserts.

Item Maximum number of sheets

Labels 25

Business cards 25

Greeting cards 25

CD/DVD labels 25

CD/DVD inserts 25

http://www.tek.com/Color_Printers/supplies" target="_blank
www.xerox.com/officeprinting/6200supplies
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Printing labels, business cards, greeting cards, CD/DVD inserts, and 
CD/DVD labels

1. If printing on labels and your application has a setting for labels, use it as a template. Templates 
for greeting cards, etc. are available at the Xerox Color Connection web site at: 
www.colorconnection.xerox.com

2. Insert the sheets into the Multi-Purpose Tray. Place the side to be printed facedown with the top of 
the sheet entering the printer first. For more information, refer to the Trays section of the Trays 
and Paper Guide on the Interactive Documentation CD-ROM.

3. When the front panel prompts you to confirm or change the selected paper type and size:

a. Press the Down Arrow key to scroll to Change, then press the OK key.

b. Scroll to the correct type and press the OK key to save your selection.

c. Scroll to the correct size and press the OK key to save your selection.

4. In the printer driver, select either Multi-Purpose Tray as the paper source or the paper type.

6200-55
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